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File Menu

The    File menu includes commands that ler you save the current MIDI Director Setup and 
Exit the MIDI Director Control Panel.

Exit Exits the MIDI Director Control Panel.
Save Settings Saves the current Global Settings of the MIDI Director.



Options Menu

The Options Menu contains commands that let you change different MIDI Director settings 
and also show the Status and Errors windows.

For more information select the command name from below.

Show Status ... Show the Status Window.
Show Errors ... Show the Errors Window.
MIDI Echo Turn MIDI Echo on or off for all inputs.
Send MIDI Clocks Send MIDI Clocks and Song Position Pointer when in play mode.
Recognize MIDI Start Control playback in internal Sync Mode    from MIDI. 



Settings Menu

The Settings Menu contains selections that let you set options for the Metronome Settings, 
Sync Settings, Input Setup and Output Mapping.

For more information select one of the following Settings menu commands.

Metronome Settings
Sync Settings
Input Setup
Output Mapping



Help Menu

Shows Help commands and the command for showing the About Dialog Box. The About 
Dialog shows the version number, author name and some other    information.



Metronome Mode

To set the current metronome mode select the Active check box and one of the two radio 
buttons in the Metronome group on the main MIDI Director Control Panel window.

When Active is checked the metronome is turned on. This setting can be changed by 
programs, so your sequencer might change this setting once you load a new song. However,
programs that change this setting normally allow you to set it with their own commands.

You may select one of two metronome modes, MIDI Notes or PC Speaker. 
MIDI Notes send MIDI Notes out the MIDI output with the note values selected in the 
Metronome Settings dialog box.
When the PC Speaker is selected, you hear the metronome through your PC's speaker. You 
can adjust the pitch (note) of the metronome, as well as other settings, from the Metronome 
Settings dialog box. 



Metronome Settings

The metronome settings are controlled from the Metronome Settings dialog, which is 
accessed from the Settings Menu. The metronome settings dialog has selections for setting 
the notes used for the normal and accent metronome sound, the number of count in beats 
and the MIDI Output and MIDI Channel used to send the metronome to when using the MIDI 
metronome.

For both the MIDI and PC Speaker Metronome Mode settings, you can set the note number 
(pitch), velocity and the duration of the note. You can also specify a Count In value, that is 
used when in Internal Sync Mode.

Tick Note The note used for each metronome tick. It is specified in MIDI note numbers 
(0-127). The pitch of the PC speaker is also affected by this settings.

Tick VelocityThe Loudness of the note when using the MIDI metronome, This setting has no
effect on the PC Speaker.

Note Duration How long the metronome tick is played in metronome ticks (0-239 
ticks).

Count In Beats How many beats to use as a count in when in MIDI Sync mode.

Accent When the accent check box is checked, the first beat of each measure is 
played with an accent. The accent settings for Note and Velocity are set thew 
same as those for Tick Note and Velocity.

Accent Note The note used for accented metronome ticks. It is specified in MIDI note 
numbers (0-127). The pitch of the PC speaker is also affected by this setting.

Accent Velocity The Loudness of the accented tick note when using the MIDI 
metronome, This setting has no effect on the PC Speaker.

When using the MIDI Metronome Mode setting, you also have the following two additional 
settings.

MIDI Output Select the MIDI output you'd like to send the metronome notes to.
MIDI Channel Selects the MIDI Channel to send the metronome notes to.



Sync Mode

To set the current Sync mode select one of the three radio buttons in the Sync group on the 
main MIDI Director Control Panel window.

The selections are 

Internal Clock uses the internal timer of the PC to provide timing. 

MIDI Clocks/SPP lets you sync to external sources such as other sequencers, drum 
machines or other devices capable of MIDI sync. With this setting the MIDI 
Director also responds to Song Position Pointer by directing all running 
sequencers to seek to the new song position. You can also use this setting for 
devices that use Chase Lock Sync, Smart FSK or other Song Position based 
tape syncs.

MIDI Time Code MIDI time code is used with SMPTE converters to povide SMPTE tape 
sync. Some high end MIDI interfaces also include SMPTE converters built in. 
Select this setting for both SMPTE and MTC syncs.

Also see    Sync Settings.



Sync Settings

The Sync Settings dialog box lets you tell the MIDI Director which port to recognize both MIDI
and MIDI Time Code syncs from. You can also set the MTC offset used when using MTC sync, 
and whether to Echo MTC messages received .

Sync Input Port The port that MIDI sync with Song Pointer    and MIDI Time Code when 
in these modes. It also controls the port that MIDI Start, Stop and Continue are
recognized when in internal sync and Recognize MIDI Start is checked in the 
Options Menu. 

Echo MTC When in MTC sync mode, echo MIDI Time Code messages out the MIDI thru 
port specified for the Sync Input Port specified in the Input Setup for that port.

MTC Offset lets you specify the Hours, Minutes, Seconds and Frames to use as a sequence
start position when using MTC Sync. You may also be able to set this from 
within your sequencer. If so, loading a song will probably over-ride any value 
you might enter. In these cases, set the offset from your sequencer.



Input Setup

Select Input Settings from the Settings Menu to display the Input Setups dialog box, which 
lets you change several settings used to control MIDI input filtering, rechannelizing and per-
input MIDI Echo.

MIDI Input selects the input to change the settings on. Click on the arrow to show more 
selections.

Activate Input, when checked, makes the MIDI input active. When not checked, the 
input port will be ignored. No MIDI data will be echoed or sent to programs.

Rechannelizing 
MIDI Channel lets you rechannel all MIDI data from the input to a new MIDI channel. 

This parameter's settings are OFF (no channelizing) or    between 1-16. When 
set between 1-16, all MIDI channel data will be rechannelized to the selected 
channel.

Echo Output Allows you to select which output to echo the selected input's MIDI data to. 
The 'Don't Echo' selection turns off echoing for this input. Note that when the 
Global MIDI Echo is turned off    in the Options Menu that this setting will be 
suspended.

Input    Enable 
Sets which MIDI Data is recognized from this port.



Input Enable

The input enable section of Input Setup dialog box lets you select what kinds of MIDI Data 
will be received from an input. When an item is checked, the data will be received.    Your 
choices are 

Notes MIDI Note On and Note Off commands are received when checked.

Bender Pitch Wheel (Bender) data is received when checked.

Controllers Continuous contoller messages are received when checked.

Channel Messages Channel Messages are passed. These comprise of program changes, 
control changes and other channel based messages.

Aftertouch Both Channel Aftertouch and Key (polyphonic) aftertouch messages are 
passed when this is checked.

Common System Common messages are passed. Common messages include Song 
Select messages.

System Exclusive System exclusive (SYSEX) are passed. These include parameter changes
from synthesizers as well as dumps from samplers.



Output Mapping

Select output mappings from the Settings Menu to display the Output Port Mapping dialog 
box, which lets you select the mapping mode of each MIDI output port. You can select a 
Keyboard Map and a Program Change Map for each of the 16 MIDI channels available on 
each port. You can edit these maps and customize them to your own tastes. 

The Output Port Mapping dialog box lets you select the output port and MIDI channel by 
using the controls at the top of the dialog box. The Output Port combo box lets you select 
the output to view. The MIDI Channel edit control lets you select the output port channel to 
see the maps for. 

You can select both a Keyboard Map and a Program Change Map for each MIDI channel of 
each MIDI output. To select a map you would just select the map name from either the 
Keyboard Map list box or the Program Change Map list box. The No Mapping selection turns 
off mapping for that channel.

When you select a map, the Edit button will become active. You can then edit the map 
parameters by clicking on the Edit Button. The appropriate Map Edit dialog will be displayed.

When you are done editing your maps you can select the Save Maps button to store your 
changes and make your changes permanent. If you don't want your changes to be kept for 
future sessions, don't select Save Maps, and the MIDI Director will load your old maps the 
next time it is started. To store your map selections you need to select    the Save Current 
Settings command from the File menu.



Keyboard Maps

The Keyboard Map remaps note values to new note values. The most common use for 
Keyboard Maps is to re-arrange notes recorded for one drum machine or drum sound source 
to be played by another. For instance a Bass Drum might be note number 36 on one sound 
source and 32 on another. Normally, you would have to remap every note in your sequence 
for the new sound source. But by using a Keyboard Map, you can leave the sequence data 
alone and hear the right percussion instruments. Most of the default Keyboard Maps are set 
to remap different drums machines to the General MIDI Specification. This specification calls 
for certain drums sounds to be on certain keys. You can create a General MIDI compatible 
drum part, but play it on any sound source with compatible sounds. But these sounds don't 
have to be on the normal keys, since you can remap them to new ones with the Keyboard 
Map. There are eight maps available.

Of course, you can also use the Keyboard Maps to transpose your keyboard, invert your 
keyboard or even play different sound sources from one keyboard by transmitting on two or 
more channels at once. 

To modify a Keyboard Map, select the map name from the Keyboard Map List Box in the 
Output Port Mapping dialog.    You will notice that the Edit button will then become active. 
Click on the Edit button to modify the map.    The Keyboard Map Edit dialog box will then 
display.

Editing the Keyboard Map

The Keyboard Map Name is shown at the top of the dialog. You can select the Key Map Name
edit control to change the map's name. In the bottom portion of the dialog box are the key 
edit fields and the Key list box that shows the values for each key (or note). The list box has 
values for all 128 notes. You can use the scroll bar to see all of the values.

The Keyboard Map parameters are Source, Key Name, Dest, Chan and Port. 

Source is the source key. You can't change this value. It is a reference to remind you 
which key you've chosen from the list box. 

Key Name is used to describe the key. For drum sound mapping, you would enter the 
name of the instrument played by the key. 

Dest (or Destination) is the Destination key. When the source key is played it will be
translated to the note value in Dest. The value of this parameter may be 
between 0 and 127, which is the range of valid MIDI note numbers.

Chan is the MIDI Channel to use when the note is played. When set to OFF, no 
channel remapping is used, but values between 1 and 16 will let you 
rechannel the note. This value takes precedence over the Input Port channel 
remapping.

Port The output to send the note to. When set to OFF, no port remapping is used, 
but values between 1 and the number of the top port will let you send the 
note to a different output. This value takes precedence over the Input Port 
Echo setting. By using channel and port remapping you can redirect output to 
several sound sources at once.

When you are done editing you can select the OK button to return to the Output Port 



Mapping dialog box.



Program Change Maps

The Program Change Map remaps patch changes to new values. The most common use for 
Program Change Maps is to re-arrange patch changes recorded for one sound module to 
those of another. For instance a Bass Drum might be note number 36 on one sound source 
and 32 on another. Normally, you would have to remap every note in your sequence for the 
new sound source. But by using a Keyboard Map, you can leave the sequence data alone 
and hear the right percussion instruments. Our default maps are set up for the General MIDI 
Specification.    This specification calls for certain instrument sounds to be at specific patch 
change numbers. You can create a General MIDI compatible sequence, complete with sound 
selection, but play it on any sound source with compatible sounds. But these sounds don't 
have to at the same locations as your instrument's, since you can remap them to new ones 
with the Program Change Map. There are eight maps available.

To modify a Program Change Map, select the map name from the Program Change Map List 
Box in the Output Port Mapping dialog.    You will notice that the Edit button will then become
active. Click on the Edit button to modify the map.    The Program Change Map Edit dialog 
box will then display.

Editing the Program Change Map

The Program Change Map Name is shown at the top of the dialog. You can select the 
Program Change Map Name edit control to change the map's name. In the bottom portion of 
the dialog box are the program change edit fields and the Program Change list box that 
shows the mapping values for Program Change. The list box has values for all 128 program 
changes. You can use the scroll bar to see all of the values.

The Program Change Map parameters are Source, Program Name and Dest. 

Source is the source program change. You can't change this value. It is a reference to 
remind you which program change you've chosen from the list box. 

Program Change Name is used to describe the instrument associated with the program 
change. 

Dest (or Destination) is the Destination program change. When the source program 
change is selected it will be translated to the value in Dest. The value of this 
parameter may be between 0 and 127, which is the range of valid MIDI 
program changes.

When you are done editing you can select the OK button to return to the Output Port 
Mapping dialog box.



Error Window

The error windows provides statistics useful for finding out problems that may be occuring in
your setup. You don't really need to keep track of your errors since the MIDI Director is self 
correcting and will usually recover from most errors. See your owner's manual for more 
information.



The Status Window

The Status window has three displays. The Mode display, the Programs count and the 
Position display.

The Mode display shows the current status of the MIDI Director. It is found on the upper left
of the status window. When you first start up the Control panel from your 
program, this will read Stopped. When the sequencer is in playback mode, it 
will read Playing. It can also tell you when you are in Fast Forward and will 
also show Rewind after a rewind.

The Programs count shows how many programs are logged on to the MIDI Director. Since 
some programs may log on more than once, this may show more programs 
than are actually running. Currently the MIDI director supports up to sixteen 
programs at once.

The Position display shows the current position the MIDI Director is set to or is playing 
from. Both the Tick position and the Millisecond positions are displayed. When 
MIDI Director's Sync Mode is    set to MTC (MIDI Time Code) then the 
Milliseconds position display will show the current 
HOURS:MINUTES:SECONDS:FRAMES when chasing to start playback. It will 
then revert to milliseconds when playback has started. The line below the 
Millisends Position display also shows other information about the frame 
format and MTC status when in MTC sync.





      Windows Keys

The MIDI Director uses the keyboard interface that is standard to all Windows programs.    
Choose from the following list to review the standard keys used in Windows:

Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



        Cursor Movement Keys
Key(s) Function
DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left ArrowMoves to the beginning of a field.

PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



        Dialog Box Keys
Key(s)Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.

ENTER Executes a command button.
Or, chooses the selected item in a list box and executes the command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.

SPACEBAR Cancels a selection in a list box.
Selects or clears a check box.

CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.

SHIFT+ END Extends selection to last character in a text box



        Editing Keys
Key(s)Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



        Help Keys
Key(s)Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.



        Menu Keys
Key(s)Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.

Enter Chooses the selected menu item.



        System Keys
The following keys can be used from any window, regardless of the application you are 
using.
Key(s)Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.

F1 Gets Help and displays the Help Index for the application. (See Help Keys)



        Text Selection Keys
Key(s)Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is already selected.
SHIFT+PAGE UP Selects text up one window.

Or, cancels the selection if the previous window is already 
selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.

CTRL+SHIFT+HOME Selects text to the beginning of the document.



        Window Keys
Key(s)Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control menu.

Or, changes the size of a window when you have chosen Size from the Control menu.





Glossary
Accent is an emphasis placed on a note to make it stand out.

Aftertouch A MIDI command that specifies how hard a key is pressed after it has been 
struck initially. Aftertouch is commonly used for volume swells, filter sweeps and 
other effects. The MIDI Spec defines two type of Aftertouch, channel and polyphonic. 
Channel Aftertouch, also called channel pressure, effects all notes on a MIDI Channel. 
Polyphonic aftertouch, also known as polyphonic key pressure, effects only individual 
notes on a channel. Of the two, channel aftertouch is the most common.

Bend Bend, or Pitch Bend, is the changing of a sounding note up or down in pitch in a 
smooth fashion. The term pitch bend is taken from the guitar, where the player will 
stretch the string to produce a bending effect. Synthesizers produce this same effect 
with the use of a pitch wheel.

Channel Channel is a logical path to send MIDI data. MIDI has sixteen channels per port.

Channel Message A MIDI command that only affects one MIDI channel. These include note 
on and note off, program changes, pitch wheel and control change messages.

Chase Lock Sync a type of tape sync found in Music QuestTM    brand MIDI interfaces, also 
called smart FSK on other types of interfaces or sync boxes.

Clock A Clock is a way of measuring time, that when applied to MIDI usually measures the 
subdivisions of a beat. MIDI director uses a clock that will time stamp data with either
milliseconds or ticks (or 240ths of a beat).

Common Message A MIDI command that is sent on a port and affects all MIDI channels, 
not just one. A good example of common messages are the MIDI start, stop and 
continue commands. 

Control Change A MIDI message that    affects different MIDI controllers. The most common 
controllers are Modulation Wheel, Volume and Hold (or sustain) pedal controllers. 

Count In A count in is used to tell the performer that the music is about to start. A common 
count in would be a count of one measure.

Dialog Box A dialog box is special window that allows the user to enter information. Unlike 
normal windows, a user cannot switch out of a dialog until he is done.

Driver A Driver is special type of program that allows the MIDI Director to communicate with
each MIDI interface.

Duration The length of time that a note occurs. When used with the MIDI Director's 
metronome, it specifies how many ticks long a note is.



Echo Echo, or MIDI echo, is used to describe the action of passing MIDI data from a MIDI 
input to an output. Also known as MIDI thru.
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Frames The frame is the    subdivision of a second used by MIDI Time Code and SMPTE sync 
to mark the passage of time. The most convenient frame rate to use for music 
applications is 30 non drop frame.

Keyboard A music instrument used to play notes.

MIDI An    that stands for acronym Musical Instrument Digital Interface. MIDI is a standard 
form of digital communication that is used between electronic music instruments, 
especially electronic keyboards.

MIDI Continue A MIDI Command that tells a sequencer or drums machine to start playing 
from the position where it was last stopped or positioned to with a Song Position 
Pointer message.

MIDI Director A MIDI multitasking software system, from Big Noise Software, Inc., that 
allows several MIDI programs to run at once under Microsoft Windows. The MIDI 
Director allows programs to share a number of MIDI interfaces and lets programs lock
to external devices.

MIDI Start A MIDI Command that tells a sequencer or drums machine to start playing from 
the beginning of the song.

MIDI Stop A MIDI Command that tells a sequencer or drums machine to stop playing.

MIDI Sync A form synchronization specified in the MIDI Specification 1.0 that    lets two MIDI 
devices play together. MIDI sync is based on the musical format of beats and tempo.

MIDI Time Code A time based synchronization code that is commonly used when locking 
MIDI devices to SMPTE based devices. 

Milliseconds One thousandth of a second. The MIDI Director uses a time base of 1    
millisecond to record and playback all MIDI data.

Module A module is a synthesizer or sampler that does not have an attached keyboard.

MTC Short for MIDI Time Code. See MIDI Time Code above.

Note On/Off MIDI Commands that identify the start and stop of notes. A note on is sent 
from a keyboard when the note is pressed and a note off is sent when the note is 
released.

Note Number A number between 0 and 127 that indicates what note is pressed. Middle C is
note number 60. All notes are specified in half steps.



Notes Notes are the basic building block of music. A note in MIDI consists of a Note On 
command and a Note off command.

Patch Change A patch change, also known as program change, is a MIDI command that 
tells a keyboard or module what sound to play.
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Pitch Bend Pitch Bend, or just Bend, is the changing of a sounding note up or down in pitch 
in a smooth fashion. The term pitch bend is taken from the guitar, where the player 
will stretch the string to produce a bending effect. Synthesizers produce this same 
effect with the use of a pitch wheel.

Polyphonic Key Pressure See Aftertouch.

Port, MIDI A MIDI port is where the MIDI cable is plugged in. The MIDI Director can control a
number    MIDI ports. Each MIDI port can send or receive data on up to sixteen MIDI 
channels.

Position A point in a song , when used with sequencers. A position may be described in the 
common musical terms of measures and beats, with the beat subdivided into ticks. A 
song position can also be described    in terms of time, as in milliseconds.

Program Change A program change, also known as patch change, is a MIDI command 
that tells a keyboard or module what sound to play.

Rechannel The changing of the MIDI channel data is received with to another channel. This 
is very useful when sequencing.

Sample A recorded sound played    back through a Sampler.

Sampler A special type of keyboard that plays back recorded sounds.

Save When used with computers, save means to store to disk.

Sequence A recording of a song as performance data, such as MIDI data, instead of as 
sound.

Sequencer A computer program, or hardware device, that records a performance as MIDI 
data. Cadenza for Windows is a sequencer.

SMPTE An acronym that stands for the Society of Motion Picture and Television Engineers, 
used to describe a form of synchronization code used in the movie and television 
industry. Originally developed by NASA, SMPTE is also commonly used to sync high 
end audio equipment such as multitrack tape recorders.

SMPTE Sync A form of tape sync commonly used to synchronize MIDI equipment to video 
equipment and professional recording equipment. Use of SMPTE sync usually requires
the use if a SMPTE to MIDI Time Code converter.

Song Position The measure, beat and tick position in a song.

Song Position Pointer A MIDI command that tells a sequencer what measure, beat and 



tick to position to before playback starts or continues.

Sync Short for synchronization.
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Synthesizer An electronic musical instrument that produces sound electronically.

System Exclusive A special MIDI command that is used for instrument specific messages, 
such as patch programming parameters or sample dumps.

Tape Sync A form of sync used to lock recorders and MIDI equipment together. SMPTE, 
Chase Lock and FSK are three types of tape sync.

Ticks Subdivisions of a beat. In the MIDI Director a tick is defined as one 240th of a beat.

Velocity Velocity is part of each MIDI Note on message that describes how hard a note was 
stuck.


